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Abstract/Summary

Two-dimensional surfaces offer simple analysis of cells in culture, yet these often yield different cell morphology and
responses than those observed in vivo. Considerable effort  has therefore been expended on the generation of more
tissue-like environments to study cell behaviour in vitro. Purified matrix proteins provide a three-dimensional scaffold
that better mimic the in vivo situation; however these are far removed from the complex tissue composition seen in
vivo.  Cell-derived  matrices  (CDMs)  offer  a  more  physiologically  relevant  alternative  to  study  in  vivo-like  cell
behaviour in vitro. In the protocol described here, fibroblasts, cultured on gelatin-coated surfaces, are maintained in the
presence of ascorbic acid to strengthen matrix deposition over 1-3 weeks. The resulting fibrillar CDMs are denuded of
cells and can be used to monitor cell behaviour. We also demonstrate how to use CDMs as in vivo–relevant reductionist
models for studying tumour-stroma-induced changes in carcinoma cell proliferation and migration.

Editorial summary
This protocol describes how to produce cell-derived matrices from fibroblasts. These matrices can be used to provide a
3-D scaffold for cell culture and to investigate cell behaviour in complex microenvironments.

Tweet  
How to use cell-derived matrices to study cell behaviour in complex 3-D microenvironments. 

Keywords: 

Cell-derived matrices, extracellular matrix, cancer-associated fibroblasts, cell-ECM interaction, cell migration, cancer
cell proliferation

1

mailto:Johanna.ivaska@utu.fi


Introduction 

Cellular interaction with the surrounding extracellular matrix (ECM) regulates almost every facet of tissue homeostasis
by providing important survival, growth and differentiation cues to cells within tissues. Historically, the vast majority of
investigations focused on cell biology have been performed in rigid 2D cell culture conditions that lack many features
of the in vivo cellular  environment.  However,  it  is  now clear that cell  behaviour and response to the extracellular
compartment are regulated by an increasingly complex set of environmental cues including ECM ligand availability and
stiffness. Tissue architecture and molecular composition, in addition to physical and mechanical properties, regulate a
vast range of biological  outcomes, including stem cell  differentiation  1,  cancer progression  2 and the acquisition of
resistance towards anti-cancer therapies 3. Development of in vitro model systems that incorporate these more complex
features of the tissue are therefore important to boost basic knowledge and progression in many cell biology fields.

Several in vitro models have been generated to mimic the 3D nature of in vivo microenvironments and these have
become increasingly popular tools in analysing cell behaviour.  These include embedding cells within 3D collagen,
fibrin gels or Matrigel. In these models, cells are typically seeded inside a non-polymerized gel that, once polymerized,
gives rise to a 3D scaffold. To increase complexity, such gels have been supplemented with additional ECM molecules
and these models have provided important insights into matrix-guided properties in 3D. For example, fibrillar collagen-
supplemented  Matrigel  supports  branching  of  mammary  epithelial  cell  organoids  4,  5 and  addition  of  fibronectin
dramatically changes the requirements for cancer cell invasion into collagen matrix plugs 6, 7. However, such systems
still fail to fully recapitulate the cell morphology of cancer cells invading in tissue (Fig. 1). Furthermore, they lack the
complexity of  the in  vivo tissue where  the ECM “matrisome” is known to be composed of hundreds of different
proteins and proteoglycans 8, 9. 

Tissue composition in vivo is the outcome of protein secretion by many different cell types. However, the main stromal-
ECM-producing cells are tissue fibroblasts and the assortment of proteins secreted and deposited by these cells  is
expected to be a close imitation of the complex in vivo protein composition. Thus, fibroblast-generated cell-derived
matrices (CDMs) are becoming an increasingly popular in vitro cell culture model as these matrices recapitulate many
of the in vivo observed phenotypes including cell morphology (Fig. 1).  CDMs generated from different cell sources,
such as cancer-associated stromal cells, podocytes, hepatic stellate cells and mesenchymal stem cells, and cells grown
under different conditions vary in composition and thus can provide a variety of microenvironments to study specific
biological questions 10-17.  In addition, the stiffness of CDMs has been found to closely resemble the in vivo range in
spite of being produced on rigid glass or plastic surfaces 18, 19. 

However, CDM preparation requires special expertise. To facilitate this, we provide here a comprehensive protocol for
the  effective  preparation  of  CDMs  using  fibroblasts.  We  also  provide  procedures  for  the  imaging  of  the  CDM
architecture and composition using immunofluorescence staining and confocal microscopy. Finally, the applicability of
CDMs as in vivo-mimicking settings to analyse cell proliferation in addition to a protocol to image, track and quantify
directional cell migration are presented.  We also provide Supplementary Videos 1-8 to guide users through the various
procedures given in the protocol. We used CDMs prepared via this protocol to monitor collagen fibre assembly by
genetically  modified  mouse  mammary  gland  fibroblasts,  to  analyse  cancer  cell  proliferation  on  patient-derived
fibroblast matrices and to assess cancer cell migration on normal fibroblast CDMs in several publications 13, 20-24.

Development of the protocol

CDMs represent a very versatile and robust 3D in vitro model with many in vivo-like characteristics of the cellular
microenvironment.  Here,  we provide a stream-lined protocol  to exploit  patient-  or  immortalised human fibroblast-
generated CDMs as a reductionist approach to investigate the biological outcome of cancer interactions with in vitro
tissue stroma-like substrates.

Cells cultured at high density in vitro have the capacity to produce a 3D matrix by natural secretion and organization of
ECM proteins. Such matrices consist of a mixture of fibrillar and signalling matrix proteins, embedded growth factors
and proteoglycans and resemble many aspects of the native tissue stroma 25. CDMs are most efficiently generated by
fibroblasts as these cells are predominantly responsible for the maintenance of the stromal ECM composition in vivo.
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The method for generating CDMs for analysis of cell adhesions in vitro was originally described by Cukierman and co-
workers in their hallmark publication  26. They used confluent monolayers of NIH-3T3 fibroblasts to deposit a matrix
layer, onto 2D plastic or glass surfaces, which was subsequently denuded of cells  26. In addition to NIH-3T3 cells,
human dermal fibroblasts and telomerase-immortalized human fibroblasts (TIFs) have been used as a source for robust
and  consistent  CDM production  6,  27,  28.  These  CDMs,  deposited  by  cells  over  a  period  of  several  days,  are  of  a
heterogeneous composition consisting primarily of linearly aligned matrix fibrils. 

The pivotal  role of  stromal  ECM as an instigator  in the development  and/or  progression of  multiple diseases  has
become increasingly apparent.  In  cancer,  the tumour microenvironment  is  altered by activated fibroblasts,  residing
within  the  stroma,  towards  a  more  conducive  setting  for  tumour  cell  survival  and  invasion.  Interestingly,  CDMs
produced by tumour-associated stromal fibroblasts recapitulate many of the architectural features of the in vivo cancer
stroma 29. This suggests that CDMs could be used as a valuable model for investigating cancer-stroma interactions in
vitro; however it  is important to note that CDMs will also contain matrix-embedded inductive factors (e.g.  growth
factors) and the biological effects of CDMs on cells will be dictated by both these signalling molecules and by the
matrix topology. In our protocol, primary fibroblasts were isolated from cancer-proximal and cancer-distal (“normal”)
head and neck squamous cell carcinoma (HNSCC) patient tissue, operated tumours and biopsies, to generate CDMs.
This allowed us to compare matrix organization in CDMs generated from normal versus cancer-associated fibroblasts
(CAFs) and importantly  to  investigate the contribution of  these matrices  to  cancer  cell  proliferation  11.  This  same
approach was additionally used to draw distinctions between CDMs deposited by wild-type and genetically modified
primary mouse mammary fibroblasts and from this to link changes in collagen architecture to defects in mammary
gland development 13. 

Experimental Design

In the first part of this protocol, we describe a method to generate CDMs from fibroblast cultures in vitro (steps 1-17).
The entire work-flow of CDM generation is presented in Fig. 2 and Supp Video 1. Supplementary videos 2-4 guide
through the critical steps in the protocol (Steps 1-17). It is important to note that the composition and properties of the
matrix can be adjusted by changing the culture conditions. For example, addition of ascorbic acid increases the collagen
content of the CDM. Ascorbic acid is essential for the hydroxylation of proline and lysine residues within collagen and
results  in  the  deposition  of  a  stable  collagen  protein,  in  its  innate  triple-helical  structure,  capable  of  forming
intermolecular cross-links 30. In addition, stimulation with growth factors such as epidermal growth factor (EGF) and
basic fibroblast growth factor (bFGF) can elevate matrix production resulting in increased matrix thickness  18, 19. The
optimal  length  of  ascorbic  acid  treatment  might  vary  between  different  cell  types  and  therefore  might  require
optimization.

The process of extraction (steps 11-17) is the most critical stage in producing CDMs for experiments. The extraction
has to be efficient enough to prevent remnants of fibroblasts from sticking to the CDM and interfering with downstream
imaging. Conversely, if the extraction is too extensive the CDMs will detach or become damaged (Fig. 3). Currently,
the most commonly used extraction method, as presented here, uses a combination of an alkaline buffer and a non-ionic
detergent  to  effectively  solubilise cytoplasmic  components  and  to  disrupt  lipid-lipid  and  lipid-protein  interactions,
respectively.  Alternative  extraction  protocols  for  CDMs  generated  by  different  cell  types  have  been  extensively
reviewed elsewhere  17.  These extraction methods employ, for example,  hypotonic cell lysis,  denaturing reagents  or
chelating agents instead of the detergent-based approach. The protocols vary in their robustness and the efficacy to
which inductive non-scaffolding components like ECM-embedded growth factors and potential soluble molecules are
retained within the CDM; however these methods have not been directly compared and the optimal extraction method is
likely to depend on the cell-type used to generate the CDMs and on the specific biological question being addressed. 

In addition to CDM generation, this protocol describes in detail how to characterize CDM composition and architecture
using immunofluorescence and confocal microscopy (Step 18, option A; Supp Video 5). Importantly, microscopy based
methods can also be used to validate the organization, as well as the thickness, of the CDMs. Here, we describe how to
apply CDMs to study cancer cell proliferation (Step 18, option B; Supp Video 6) and motility (Step 18, option C; Supp
Video 7).  Cancer  cell  proliferation  can  be  monitored  over several  days by expressing  a  fluorescent  marker  in  an
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appropriate cell line (e.g. GFP-tagged histone 2B (H2B-GFP) in HeLa cancer cells) and by using the IncuCyte-ZOOM ®

live cell incubator for automated detection of fluorescent cells. 

Finally, we describe how CDMs, amenable for use with most cell types, provide an ideal system for comprehensive
analysis of cell migration, morphology and behaviour at the molecular level through pharmacological and/or genetic
manipulation of cells and through overexpression of tagged proteins of interest. 

Comparison with other methods

As briefly discussed earlier, a variety of in vitro methods have been developed to provide a cellular microenvironment
that more accurately mimics the native in vivo state. These include embedding cells within 3D collagen gels that are
generated by neutralizing acid-extracted polymerized type I collagen. In this system, the structure and composition of
the collagen matrix can be adjusted by modifying collagen concentration or the duration of polymerization resulting in
matrices with differing stiffness, fibril thickness and pore size 31. Additional variability can be introduced using pepsin-
digested  or  non-pepsinized  collagen.  Non-pepsinized  acid-extracted  collagen  I  retains  both  N-  and  C-terminal
telopeptides, the non-helical portions of the collagen molecule that are responsible for native collagen intermolecular
crosslinking and fibrillar stability 32. Another widely applied 3D culture model uses Matrigel, a reconstituted basement
membrane mixture of laminins, collagen IV, nidogen/entactin and proteoglycans secreted by Engelbreth-Holm-Swarm
(EHS) mouse sarcoma cells, that polymerizes into a 3D gel at physiological temperatures and supports polarization of
epithelial cells into lumen-containing spheroids  33. While both of these systems are useful models for analysing cell
behaviour in 3D, they lack many of the intricacies of intact tissue in terms of architecture and composition. In addition,
the thickness of these 3D gels limits antibody penetration and therefore the level of resolution attainable with many
imaging techniques.

In contrast, CDMs are highly amenable to antibody-based staining and immunofluorescence imaging of both the matrix
and of the cells embedded within the matrix. In comparison to 3D gel systems, migrating cells in CDMs are easy to
track and the focus plane remains fairly constant over time during live-cell imaging 22, 34, 35 (Fig. 1 and Supp Video 8).
CDMs provide a structured matrix triggering spontaneous cell elongation and front-rear polarity which is relevant for
investigating cancer  invasion;  increased  persistence  of  cell  migration on CDMs strongly  correlates  with increased
invasion of cells into 3D fibronectin-containing Matrigel plugs 36. Thus, CDMs can be used to image invasive-like cell
motility without many of the challenges associated with imaging within 3D gel systems. 

In addition to the protocol given here, an alternative method for derivation of CDMs has been published 37. Technically,
the two protocols share many similarities with some variation in the cell lines used and in denudation of cells. However,
our protocol focuses on the applicability of CDMs to facilitate analysis of cell migration and cell proliferation and in
imaging CDMs. The alternative  protocol  37 describes  valuable  methods for  validating the CDMs,  such as  how to
generate 2D controls by mechanical flattening of CDMs or by replating a solubilised CDM, and for measuring ECM
fibre alignment. 

Advantages, limitations and applications of the method

CDMs are naturally produced fibrillar microenvironments with complex molecular composition and architecture and
are currently, in our opinion, the most representative in vitro model of the in vivo stroma. In addition to possessing
many in-vivo-stroma-like characteristics, CDMs, unlike 3D ECM gel models, are relatively thin (10 - 15 μm). Thism). This
property alone increases the attractiveness of CDMs in studying different biological systems as it enables the effective
delivery of oxygen and nutrients as well as infiltration of inhibitory molecules, antibodies and protein stains throughout
the  matrix.  Moreover,  when cultured  on  glass-bottom dishes,  CDMs are  amenable  to  high  magnification  live-cell
microscopy as the cells remain within the objective working distance despite being matrix embedded (Fig. 1 and Supp
video 8). Importantly, cells migrating on CDMs rapidly adhere along the fibrils and migrate in a directional manner
(haptotaxis) by adopting an elongated morphology, similar to fibroblasts in vivo  28. It is noteworthy that most cells
migrate directionally on CDMs (generated by normal fibroblasts), by following the topography of the matrix, without
the requirement for a chemokine gradient. All of these unique features support CDMs as a valuable in vitro model to
investigate  cell  behaviour  including,  but  not  limited  to,  cell  migration  and  cell  proliferation  in  a  tissue-like
microenvironment. Despite these advantages over in vitro 3D gel culture systems, CDMs do possess some limitations.
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Given that CDMs are deposited by fibroblasts, the exact composition of the matrix is not pre-defined compared to, for
example, 3D collagen or fibrin gels. Furthermore, the generation of CDMs is more time consuming than simply coating
plates with ready-made purified proteins. Reproducible and biologically functional CDM production is also critically
dependent on fibroblast quality and cell density at the initial step and throughout the procedure. In the video-guided
protocol and in Fig. 3, we have included images of optimal culture densities that will facilitate users of this technique to
achieve the best possible culture conditions. Another limitation of CDMs is the difficulties associated with fine-tuning
the matrix composition, architecture and stiffness in a controlled manner. In contrast, fibrin gels and collagen gels can
be manipulated during the crosslinking process (polymerisation time, temperature, initial concentration) to produce gels
with  different  pore  sizes.  In  addition,  methacrylated  collagen  I  can  be  used  to  produce  local  changes  in  matrix
mechanical  properties  38.  Nevertheless,  CDMs  can  be  manipulated  to  some  degree  to  address  specific  biological
questions. For example, the role of specific proteins in matrix production can be assessed by genetic modifications of
the  cells  producing  the  matrix  or  by  treatment  with  growth  factors/compounds  to  yield  matrices  with  different
properties, e.g. treatment with ascorbic acid to favour collagen crosslinking. 

CDMs to study ECM properties in health and disease. Cell behaviour is acutely influenced by ECM composition,
topography and biomechanical properties. Alterations in the extracellular microenvironment are associated with many
human ailments including fibrosis and cancer, and often allude to a more progressive stage of the disease 3, 39-42. CDMs
provide a valuable tool to study ECM parameters and associated cell behaviour. Insights into composition can be gained
by CDM solubilisation followed by western blot or mass spectrometry analysis  12,  14,  15. These targeted and/or global
unbiased  analyses  can  also  highlight  context-dependent  roles  for  specific  ECM  proteins  in  pathophysiological
conditions. For instance, mass spectrometric (MS) analyses of CDMs generated from the hepatic stellate cell line LX-2
has aided in the identification of novel ECM components associated with fibrotic liver disease 14 and MS analyses of
CDMs produced by different  fibroblast feeder cells have shed light on novel ECM proteins capable of supporting
human embryonic stem cell pluripotency 15. 

CDM organization and mechanical properties can be analysed using microscopic strategies. We and others routinely use
immunofluorescence  staining  of  classical  ECM  components  such  as  fibronectin  and  collagen  to  visualize  the
organization of CDMs (Fig. 4, protocol steps 19-24; 11, 13). For instance, using immunofluorescence we found that the
CDM produced and organized  by CAFs is  denser  compared  to  the one produced by their  healthy counterparts  11.
Immunofluorescence and immunohistochemistry can also be used to validate the presence and organization of novel
ECM components  identified using proteomic approaches  12,  14,  to measure CDM thickness,  or  to simply validate /
evaluate  CDM  production  (see  anticipated  results).  Some  of  the  tools  available  to  quantitatively  analyse  ECM
properties  from microscopy images include the image J plugins FibrilTool  43 and Orientation J  10,  the MetaMorph
software 16, 44, CytoSpectre 45 or CurveAlign and CT-FIRE 46. In addition to the immunofluorescence method outlined
here, the architecture of distinct CDMs can be further scrutinized using scanning-electron microscopy 11. Moreover, the
physical properties of CDMs, such as stiffness, can be determined using atomic force microscopy 11 (for protocol see 17).
CDMs, together with other 3D models, differ drastically from normal 2D tissue culture plastic in terms of stiffness.
While the stiffness of the tissue culture plastic is considered to be in the range of gigapascals 47, we found that CDMs
with a thickness of 10 - 15 μm). Thism have a maximum stiffness of 100 pascals  11, in range with stiffness measurements in
tissues  48. In addition, we reported that a CAF-produced CDM is stiffer than one produced by normal fibroblasts  11.
Therefore,  CDMs can be considered as a valid in vitro model to investigate the impact of matrix compliancy and
extracellular tension on different cell biological processes such as proliferation or cell migration.

CDMs to study cell proliferation. ECM composition, as well as substrate stiffness, is known to influence proliferation
of normal and transformed cells  49,  50.  We have used CDMs to explore cell-stroma interactions following replating
experiments. Using this approach, we identified a cancer cell growth inhibitory effect in CDMs generated specifically
from normal patient fibroblasts. In contrast, CDMs generated by CAFs isolated from the same patients were shown to
be less growth inhibitory 11. Our results clearly demonstrate that CDMs can be used as a 3D platform to study cancer
cell proliferation in vitro and therefore provide an alternative to other 3D methods such as spheroids formation assays
that remain difficult to automate. Here, we provide a protocol to analyse cell proliferation on CDMs using H2B-GFP-
expressing  HeLa cells  and  the  automated  incubator  microscope  IncuCyte  (Fig.  5)  but  this  protocol  can  easily  be
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extended to other  cell  types and other  imaging systems. The benefit  of  this system is that  the impact  of different
fluorescently-tagged proteins / drugs on cell proliferation can be easily monitored in a fully automated manner. We
envisage that, for instance, the protocol described here could be easily adapted as a screening platform to identify drugs
that  inhibit  cancer  cell  proliferation  in  3D.  If  an IncuCyte  system is  not  available,  proliferation on CDMs can be
analysed using time-lapse microscopy followed by appropriate image analysis to score cell numbers over time. If real-
time measurements  are  not desired,  proliferation can also be investigated on CDMs using standard  calorimetry  or
fluorescence-based cell proliferation assays.

CDMs  to  study  cell  migration. CDMs  present  a  very  versatile  tool  to  study  directional  cell  migration  in  a  3D
microenvironment (Fig. 6). We and others routinely use CDMs to assess cancer cell 20, 22, 23, 28, 51-53 or fibroblast cell 35, 54

migration parameters, such as speed and persistence (cell motility persisting in one particular direction; directional cell
migration;  haptotaxis),  in  a  more  in  vivo-like  microenvironment  by  means  of  low-magnification  bright-field  live
imaging, manual cell tracking and ImageJ-based analyses. Interestingly, migration speed on CDMs is often in the same
order of magnitude compared to migration on 2D surfaces. For instance, mouse embryonic fibroblasts were found to
migrate at 0.1 μm). Thism.min-1, 0.14 μm). Thism.min-1 and 0.08 μm). Thism.min-1 on CDMs, in 2D wound healing experiments and on 2D FN,
respectively 55 and A2780 ovarian carcinoma cells were found to migrate at 0.2-0.4 μm). Thism.min-1 on CDMs compared with
0.25 μm). Thism.min-1 in 2D wound healing assays52. In contrast, migration persistence appears to be highly dependent on ECM
properties. In the absence of a chemokine gradient, the majority of cells migrate randomly on 2D surfaces, a behaviour
that is clearly reflected by the cell’s morphology including the formation of multiple and/or broad lamellipodia and a
constitutive switch in the dominant protrusive edge; however, the same cells demonstrate high directional migration on
CDMs, generated by normal fibroblasts, by clearly following the matrix topography. Therefore, CDMs can be easily
used to assess the role of a pathway / protein / compound in directional cell migration (Fig. 6,  52,  55). In addition to
classical migration parameters, the shape and morphology of cells migrating on CDMs can be easily analysed using
both live and fixed imaging. For instance, others have demonstrated a correlation between induction of pseudopod
extensions in cancer cells migrating on CDMs and the potential of these cancer cells to invade in vitro and in vivo, a
finding that was not apparent when analysing cell morphology in 2D culture  22,  51. CDMs are also amenable to high
resolution microscopy (Fig. 1, Supp Video 8) and have been instrumental in uncovering novel modes of cell motility
including lobopodial and pseudopodial migration  22,  35,  54. In particular, as the cells remain close to the glass despite
being  matrix  embedded,  cells  migrating  on  CDMs  are  also  amenable  to  super-resolution  microscopy  (including
structure illumination microscopy) 52, high resolution FLIM/FRET measurements 22 and photo-manipulation.

Other applications. Lastly, the protocols described here can be easily adapted to generate CDMs from non-fibroblastic
cells including podocytes  12, mesenchymal stem cells and chondrocytes  56 and from co-cultures  12 to produce a more
tissue-type specific matrix, and from species-specific cells, to address different biological questions. Thus, there are
numerous potential applications for CDMs in investigating various aspects of cell-stroma biology and interactions. In
addition, a technique that helps to narrow the gap between in vitro and in vivo extracellular environments has wide
implications for tissue engineering and regenerative medicine 56.

MATERIALS

REAGENTS
 Fibroblasts of interest and corresponding growth medium. Using the provided protocol, we have successfully

generated CDMs from TIFs, primary murine mammary stromal fibroblasts and HNSCC patient-derived fibro-
blasts (examples of these are shown here), in addition to human foreskin fibroblasts. 

 Cancer cells of interest and corresponding growth medium. Here, we replate HeLa cells stably expressing H2B-
GFP and MDA-MB-231 breast cancer cells on CDMs. Previously, and using the same protocol, we have ana -
lysed the migration of osteosarcoma (U2OS) and ovarian carcinoma (A2780) cells, in addition to normal (non-
cancer) cell lines (e.g. mouse embryonic fibroblasts), on CDMs.
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 Penicillin–streptomycin (pen/strep; Sigma-Aldrich, cat. no. P4333)
 Fetal bovine serum (FBS; Sigma-Aldrich, cat. no. F9665)
 L-glutamine (Gibco, 25030149)
 Hepes (Sigma-Aldrich, cat. no. H0887)
 Non-essential amino acids (Sigma-Aldrich, cat. no. M7145)
 Phosphate buffered saline (PBS; Sigma-Aldrich, cat. no. D1408)
 Trypsin-EDTA (Sigma-Aldrich, cat. no. T4049)
 Gelatin (BD Difco™, cat. no. 214340)
 25% glutaraldehyde solution (Sigma-Aldrich, cat. no. G5882)
 Glycine (VWR, cat. no. 444495D)
 Ascorbic acid (Sigma-Aldrich, A92902)
 Triton X-100 (Fisher Scientific, cat. no. BP151-500)
 Ammonium hydroxide (NH4OH; Sigma-Aldrich, cat. no. 221228)
 DNase I (Roche, cat. no. 11284932001)
 10% formalin solution (Sigma-Aldrich, cat. no. HT5011-1CS)
 Dabco (Sigma-Aldrich, cat. no. 290734)
 Mowiol 40-88 (Sigma-Aldrich, cat. no. 8138)
 96% pure bovine serum albumin (BSA; Sigma-Aldrich, cat no. A8022)
 Horse serum (HRS; Gibco, cat. no. 16050-122)
 Antibodies:

- anti-collagen I alpha 1 antibody (Novus Biologicals, cat. no. NB600-408)
- anti-fibronectin antibody (Sigma-Aldrich, cat. no. F3648)
- Alexa Fluor® 568 goat anti-rabbit IgG (H+L) antibody (Invitrogen, cat. no. A11011)

CRITICAL: Different  antibodies  and suppliers  can  be used.  The appropriate  staining conditions and antibody
concentration recommended by the supplier should be tested and optimized accordingly.

EQUIPMENT
 

 Falcon 15-ml conical centrifuge tubes (BD Biosciences, cat. no. 352196)
 Falcon 50-ml conical centrifuge tubes (BD Biosciences, cat. no. 352070)
 Microcentrifuge tubes, 1.5 ml (Sarstedt, cat. no. 72.690.001)
 Cell culture incubator
 Centrifuge 
 Cell culture plates, 24-well (Greiner bio-one, cat. no. 662 160)
 Tissue culture treated dishes, 100 × 20 mm (Greiner bio-one, cat. no. 664 160)
 Cover glass, 13-mm diameter (VWR, cat. no. 631-1578)
 Ministart® 0.45 µm single use filters (Sartorius, cat. no. 109-16537K)
 Glass slides (VWR, cat.no. ECN631-1551)
 Tweezers
 Bürker cell counting chamber
 Bright-field microscope 
 Autoclave
 Cell culture laminar hood
 Cell culture incubator
 Bright-field incubator microscope with multi-position capabilities

 Confocal microscope
 IncuCyte ZOOM® live cell incubator (Essen Bioscience)
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REAGENT SETUP 

Fibroblast growth medium: Different media are recommended for different fibroblast cell lines. Use the medium that
is appropriate for the cell line chosen to generate the CDM. 

In our protocol, TIFs were maintained in DMEM supplemented with 1% L-glutamine, 25 mM Hepes, 10% FBS and 1%
pen/strep;  patient-derived  fibroblasts  were  cultured  in  DMEM  containing  1%  non-essential  amino  acids,  1%  L-
glutamine  and  10% FBS;  mouse  mammary stromal  fibroblasts  were  maintained  in  DMEM/F12,  5% FBS,  1% L-
glutamine and 1% pen/strep.

These culture media can be stored at +4 °C for up to one month.

Cancer cell growth medium: Different media are recommended for different cancer cell lines. Use the medium that is
appropriate for your cell line of interest.

In  our  protocol,  HeLa  cells  stably  expressing  H2B-GFP  were  maintained  in  DMEM  (4500  mg l−1 glucose)
supplemented  with  1%  L-glutamine,  10  mM  Hepes  and  10%  FBS.  MDA-MB-231  cells,  used  in  the  migration
experiments, were maintained in DMEM (4500 mg l−1 glucose) supplemented with 1% L-glutamine and 10% FBS. 

These culture media can be stored at +4 °C for up to one month.

1 % (wt/vol) gelatin: Prepare a 1% (wt/vol) stock solution by adding 1 g of gelatin to 100 ml of PBS. Autoclave for 1.5
h at 121 °C. Autoclaved gelatin can be stored at +4 °C for several months.  Pre-warm the stock solution in a +37 °C
water bath before use.

1 M glycine: Prepare 1 M glycine by solubilizing 3.75 g of glycine in 50 ml of PBS. Sterile filter through a 0.45 μm). Thism
filter. Sterile solution can be stored at +4 °C for several months. 

1 % (vol/vol) glutaraldehyde: Prepare 1 % (vol/vol) glutaraldehyde by adding 1 ml of the 25 % glutaraldehyde stock
solution into 24 ml of PBS. We recommend using freshly prepared 1% glutaraldehyde solution.

Ascorbic acid stock solution: Prepare a 5 mg/ml ascorbic acid stock solution by solubilizing ascorbic acid in fibroblast
growth medium. Sterile filter the solution through a 0.45 µm filter. Ascorbic acid is added to cells in fibroblast growth
medium at a final concentration of 50 µg/ml. 

CRITICAL: Due to instability of solubilized ascorbic acid, we highly recommend that the stock solution is prepared
fresh before each use. 

Extraction buffer: Prepare extraction buffer by combining 1 ml of NH4OH, 250 µl of triton X-100 and 48.75 ml of
PBS. Sterile filter through a 0.45 μm). Thism filter. Extraction buffer can be stored at +4 °C for several months. Pre-warm the
solution in a +37 °C water bath before use. 

CAUTION: Ammonium hydroxide (NH4OH) causes skin irritation and contact can lead to severe irritation and burns.
Extraction buffer should be prepared in a laminar hood and handled with care. 

DNase I stock solution (10 mg/ml): To prepare the DNase I stock solution reconstitute the lyophilized DNase I (100
mg) in 10 ml of sterile distilled water (dH2O) to obtain a stock concentration of 10 mg/ml. The DNase I stock solution
can be aliquoted and stored at -20 °C for several years.

10 µg/ml DNase I: Prepare 10 ml of 10 µg/ml DNase I solution by adding 10 µl of DNase I stock solution (10 mg/ml)
into 10 ml of sterile PBS. DNase I dilution should be prepared fresh before use. 

30 % (vol/vol) HRS: Prepare 10 ml of 30 % HRS by adding 3 ml of HRS to 7 ml of PBS. 30 % HRS can be stored for
several days at +4 °C and for longer periods at -20 °C. 

Antibody dilution buffer: Dilute antibodies in 30 % HRS. In our protocol the final antibody concentration in HRS is
either  10  μm). Thisg/ml  (primary  antibody)  or  5  μm). Thisg/ml  (secondary  antibody).  All  antibody  dilutions  should  be  prepared
immediately prior to use. We do not recommend short-term or long-term storage of diluted antibodies.
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CRITICAL: All antibodies should be diluted according to manufacturer’s recommendations and the dilution optimized
before use. 

Mowiol-mounting medium: Combine 2.4 g of Mowiol, 6 g of glycerol and 6 ml of dH2O. Stir the mixture at +22 °C
for several hours until Mowiol is dissolved. Clarify by centrifugation (5000 x g, 15 min). Add 2.5 g Dabco and store at -
20 °C for up to 12 months.

1 % (wt/vol) heat-denatured BSA: Prepare a 1 % BSA blocking solution by diluting 10 mg of 96% pure BSA in 1 ml
of PBS. Heat the solution at 85 °C for 10 min and cool at room temperature (RT). Sterile filter the solution through a
0.45 μm). Thism filter. Heat-denatured BSA should be prepared fresh before use.

EQUIPMENT SETUP 

Cell culture laminar hood and incubator

The generation of CDMs requires access to standard cell culture equipment including a laminar hood, a cell culture
incubator and a bright-field microscope. No particular set-up is required.

Confocal microscope

A confocal microscope can be used to visualize CDMs stained for ECM molecules (e.g. collagen I and fibronectin)
(Fig. 1 and Fig. 4). The confocal microscope capabilities need to match the fluorescent probes used to stain the CDM
but otherwise no particular set-up is required. Images displayed here were acquired with a Zeiss spinning disc confocal
(Orca-ER camera (Hamamatsu Photonics), Plan-Neofluar 40x or 63x oil /1.4 numerical aperture (NA) objective (Carl
Zeiss)) or with a Zeiss LSM780 laser scanning confocal (63x water/1.4 NA objective (Carl Zeiss)).

IncuCyte-ZOOM® 

An IncuCyte ZOOM® live-cell microscopy incubator can be used to measure the proliferation of labelled cells (Fig. 5).
No particular set-up is required and detailed instructions for using the instrument can be found in the protocol (Step 18,
option B). 

Bright-field incubator microscope with multi-position capabilities

To monitor cell migration on CDMs, we recommend the use of a bright-field incubator microscope equipped with a 10x
or 20x objective. The data presented in Fig. 6 were acquired using an inverted widefield microscope (AxioCam MRm
camera,  EL Plan-Neofluar  10x/0.5 NA objective (Carl  Zeiss)) equipped with a heated chamber (+37 °C) and CO 2

controller (5%). We normally collect images every 10 min which was found to be a suitable time interval for all cell
types we studied.

PROCEDURE

Steps 1-6: Preparation of gelatin-coated coverslips (Timing 2-2.5 h)
CRITICAL: This section is illustrated in Supp Video 2.

1) Place sterile uncoated glass coverslips in a sterile 24-well plate. CRITICAL STEP: To avoid contamination,
sterilise coverslips prior to use and perform all steps in a laminar hood unless otherwise stated.

2) Add 800 μm). Thisl of sterile 0.2 % (wt/vol) gelatin (stock pre-warmed at +37 °C and diluted in sterile PBS) to each well
containing a coverslip. Incubate for 1 h at +37 °C.  
PAUSE POINT: Coverslips can alternatively be incubated with gelatin overnight at +4 °C.

3) Aspirate gelatin and wash coverslips with sterile PBS. Crosslink the coated gelatin with 500 μm). Thisl of sterile 1%
(vol/vol) glutaraldehyde for 30 min at RT (room temperature; 20 °C).

CAUTION: Glutaraldehyde is irritating to the eyes, respiratory system and skin. Glutaraldehyde solution should be
handled with care and waste should be collected in a separate waste container to be disposed of according to proper
safety procedures. 

4) Aspirate crosslinker, wash coverslips with sterile PBS and quench any remaining glutaraldehyde with 500 μm). Thisl of
sterile 1 M glycine for 20 min at RT.
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5) Aspirate glycine and wash coverslips with sterile PBS. 
6) If the coverslips are to be used immediately, incubate the coverslips in the fibroblast growth medium for 1 h

before use.

PAUSE POINT: Gelatin-coated coverslips  can  be used immediately or  stored  at  +4 °C overnight  in 1% (vol/vol)
pen/strep. 

Steps 7-10: CDM production by fibroblasts (Timing 7-21 days)
CRITICAL: This section is illustrated in Supp Video 3.

7) Remove the growth medium from fibroblasts of choice. Wash cells with 5 ml of sterile PBS, remove PBS and
add 2 ml of 1x trypsin (volumes are adjusted for a confluent 10 cm culture dish). Incubate plates at +37 °C until
all the cells have detached. Quench trypsin by adding 2 ml of fibroblast growth medium and then collect the
cells by centrifugation (375x g, 3 min). Discard supernatant and re-suspend the remaining cell pellet in 4 ml of
fibroblast growth medium.

8) Count cells  using a method of  choice and plate an appropriate  number of  cells  on the previously prepared
gelatin-coated coverslips to form a confluent monolayer overnight. For TIFs, we use 5 x 104 cells per well.

CRITICAL STEP: To ensure the formation of a strong and reproducible CDM it  is  important  to use low passage
fibroblasts. 

9) When fibroblasts have formed a confluent monolayer replace medium with 800 μm). Thisl of fibroblast growth medium
supplemented with ascorbic acid (50 μm). Thisg/ml; stock ascorbic acid is sterile filtered using a 0.45 μm). Thism filter).  TIFs
usually form a confluent monolayer by day 2 after plating (Fig. 3b). 

CRITICAL STEP: Cell confluence should be assessed using a phase contrast microscope. A confluent cell monolayer is
vital before the start of ascorbic acid treatment (Fig. 3a,b); if cells are too sparse CDMs will not form properly (Fig.
3a,f) and it is recommended to delay the start of ascorbic acid treatment until a monolayer is achieved. 

? TROUBLESHOOTING

10) Repeat the ascorbic acid treatment every day or every other day (see below for clarification) for 7-21 days.

CRITICAL STEP: Ascorbic acid promotes collagen crosslinking, therefore the length and frequency of ascorbic acid
treatment can be modified for optimal experimental conditions. For instance, we routinely treat TIFs with ascorbic acid-
containing medium every other day to produce a fibronectin-rich fibrillar matrix ideal for cell migration experiments.
For the proliferation assays described below we treated cells daily with fresh ascorbic acid-containing medium. The
length of the ascorbic acid treatment depends on the fibroblast cell line used, but normally 7-10 days is sufficient.
However, primary fibroblasts may need to be treated for longer (e.g. 21 days).

CRITICAL STEP: Ascorbic acid is unstable in solution. Prepare fresh stock before each use.

? TROUBLESHOOTING

Steps 11-17: CDM extraction (Timing 1 h) 
CRITICAL: This section is illustrated in Supp Video 4.

11) Following the completion of the ascorbic acid treatment, remove medium from wells and wash cells with PBS.
12) Denude (remove) fibroblasts from CDMs by adding 500 μm). Thisl of pre-warmed sterile extraction solution. 

CRITICAL STEP: Cell denudation can be observed under a light microscope and the length of treatment has to be
optimized for each cell line. For TIFs, denudation normally occurs within 2 min (Fig. 3c and Video 4).

CAUTION: NH4OH contact with eyes and/or skin will cause severe irritation and burns. 
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13) Following denudation, remove the extraction buffer  immediately by gentle pipetting to avoid disrupting the
matrix. 

CRITICAL STEP: From this point onwards, use gentle pipetting for all washes and additions. Do not use an aspirator as
this may also remove the deposited CDM. The fibrillar network of the CDM can be observed using a light microscope
(Fig. 3) and should be monitored between each of the following steps.

? TROUBLESHOOTING

14) Wash CDMs twice with 800 μm). Thisl of PBS.
15) Remove residual cellular DNA by adding 500 μm). Thisl of 10 μm). Thisg/ml DNase I and incubating at +37 °C for 30 min.

CRITICAL STEP: Efficacy of the DNase treatment should be checked under the light microscope -  nuclear debris
appear as small black aggregates sticking to the matrix - and the length of treatment should be optimized for each cell
line to remove as much of the debris as possible defined by a reduction in aggregates. 

16) Remove the DNase I solution and wash CDMs twice with 800 μm). Thisl of PBS.
17) Observe  the extracted  CDM carefully  using bright-field microscopy to validate matrix  integrity  (Fig.  3).  If

matrix integrity is intact, proceed to further analyses. 

CRITICAL STEP: A CDM batch can also be further validated using immunofluorescence (Step 18, option A and Fig.
4) or by replating cells (Fig. 3).

PAUSE POINT: CDMs can be used immediately or stored for several weeks (up to one month) at +4 °C in 1% (vol/vol)
pen/strep. 

Further analyses using CDMs
18)  Option A describes immunofluorescence staining of CDMs, option B describes analysis of cell proliferation on

CDMs using IncuCyte-ZOOM® and option C describes analysis of directional cell migration on CDMs and
quantification of cell migration on CDMs using ImageJ and the Chemotaxis tool.

A: Immunofluorescence staining of CDMs (Video 5, Timing 3-3.5 h) 

i. Fix CDMs in 500 μm). Thisl of 10% formalin for 15 min at RT.

CAUTION:  Formalin is  toxic and  irritating to  the eyes,  respiratory  system and skin.  Formalin should be
handled with care and waste should be collected in a separate waste container and disposed of according to
proper safety procedures. 

ii. Remove fixative, wash CDMs with 800 μm). Thisl of PBS and block with 500 μm). Thisl of 30 % (vol/vol) HRS for 15 min at
RT.

iii. Remove blocking solution and incubate CDMs with 200 μm). Thisl of primary antibodies (diluted in 30% HRS) for 1 h
at RT. Here, we used collagen I and fibronectin staining to visualize the matrices. Both antibodies indicated
here were used at a final concentration of 10 μm). Thisg/ml.

iv. Remove primary  antibodies,  wash  CDMs three  times with  800 μm). Thisl  of  PBS and incubate  with  appropriate
secondary antibody (e.g. Alexa Fluor® goat anti-rabbit; final concentration 5 μm). Thisg/ml in 30% HRS) for 1 h at RT.

v. Remove secondary antibodies and wash CDMs three times with 800 μm). Thisl PBS and 1 x with 800 μm). Thisl of dH2O.
vi. Mount the coverslips on microscope slides using an appropriate mounting media (e.g. 7 μm). Thisl of Mowiol) and

image using a confocal microscope (possible settings include 63x objective, 1 μm). Thism step size) (Fig. 4).

PAUSE POINT: Coverslips mounted on slides can be kept at +4 °C, in the dark, for several months.
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B: Analysis of cell proliferation on CDMs using IncuCyte-ZOOM® (Video 6, Timing: 2-5 days)

CRITICAL: Timing depends on the carcinoma cell line used. For slow-dividing cells it is often beneficial to analyze
proliferation over a longer time point. 
 

i. To facilitate quantification of cell proliferation on CDMs, transfect cells of choice with a green fluorescent
protein (GFP). Plate 5 x 103 GFP-expressing cells on CDMs and on tissue culture plastic for comparison. We
routinely use HeLa cells stably expressing H2B-GFP (HeLa-H2B-GFP) and allow the cells to adhere for 2 h
before imaging (time-lapse video or microscope image can be used to visualize HeLa-H2B-GFP cells).

ii. Place the plate in an IncuCyte-ZOOM® incubator microscope and image cells over several days (e.g. 4 days).
Phase-contrast and green fluorescence images are taken automatically every two hours using a 10x objective
(Fig.5).

PAUSE POINT: Subsequent data analyses can be performed at a later stage.

iii. Analyse cell proliferation by obtaining cell numbers at selected time points (e.g. every 24 h). The number of
cells can be quantified automatically using fluorescence-based thresholding within the IncuCyte software.

iv. Double click on your plate on the “Vessel View” and select a representative image and add it to the image
collection. Create a new image collection and select the channels that you want to be analysed (e.g. phase and
green channels if GFP-expressing cells are used).

v. Once the image collection is saved, start a “New Processing Definition”. Select the image collection that you
created from the dropdown menu and use the top-hat background subtraction to define the objects (e.g. HeLa-
H2B-GFP  cells).  Use  mean  intensity  to  define  the  parameters  that  will  differentiate  between  cells  and
background signals (it is useful to define the pixel intensity of the cells by placing the mouse pointer on top of
the cells). Click preview and wait until the “Preview Status” is complete. Select the “Green Object Mask” and
evaluate  segmentation  from  the  image.  When  satisfied  that  the  segmentation  is  representative,  save  the
“Processing Definition” (File > Save).

vi. Click on the “Launch New Analysis Job” link within the “Vessel View” and name the “Analysis Job”. Define
the “Processing Scope” by selecting a defined time range from the dropdown menu. Select the wells to be
analysed  by clicking.  Data  processing will  now begin. A status window will  open displaying the time to
complete the analysis job. Double click the “Analysis Job” at the bottom of the “Vessel View” window.

vii. In order to export the data, go to the graph/export tab and press export. A window will open where you can
select objects to be analysed and define time range, and wells to be analysed. When the parameters are defined,
press graph or export the data (Fig. 5).

C: Analysis of directional cell migration on CDMs (Video 7, Timing: 1-2 days for recording and 2-5 days for
analysis)

i. Wash CDMs twice with sterile PBS.
ii. Block CDMs with 10 mg/ml heat-denatured BSA (>96% pure BSA). Alternatively,  block the plates using

FBS-containing medium if serum will be used in the assay.
iii. Wash CDMs three times with sterile PBS.
iv. Remove growth medium from cells of choice. Wash cells with 5 ml of sterile PBS, remove the PBS and add 2

ml of 1 x trypsin (volumes are adjusted for a 10 cm culture dish). Incubate plates at +37 °C until all the cells
have detached. Quench trypsin by adding 2 ml of growth medium and then collect the cells by centrifugation
(375 x g, 3 min). Remove supernatant and re-suspend the remaining cell pellet in 4 ml of growth medium.

v. Count cells using a method of choice and re-suspend the cells at a density of 5 x 10 3 cells/ml. Use 2 ml for a
well of a 6 well-plate and 500 μm). Thisl for a well of a 24 well-plate.
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CRITICAL STEP: Cell density should be optimized for each cell type. Analysis of cell migration requires
single cells not undergoing division. Cell-cell contacts and cell division can add variability to the results and
therefore should be avoided where possible unless these are the specific parameters being investigated.

? TROUBLESHOOTING

vi. Allow the cells to spread on, and integrate within, CDMs for at least 4 h before starting to image.
vii. Use  a bright-field  incubator  microscope with multi-position capabilities.  To ensure  cellular  viability,  it  is

important to maintain cells in a humidified chamber at +37 °C and 5% (vol/vol) CO 2 during the imaging
process. For efficient tracking of cells, use a 10x or 20x objective, take pictures every 10 min and record over
16 to 24 h (Fig. 6).

viii. Record at least five positions in each well per condition.

PAUSE POINT: Subsequent data analyses can be performed at a later stage.

ix. Using ImageJ, create a stack for each recorded position. If the cells are not very mobile, consider creating a
new stack  containing  only images  taken  every  20 or  30  min  using  the “Increment”  option in  the  “Slice
Remover” plug-in. In Fiji ImageJ, this plugin can be found under: Image > Stacks > Tools > Slice Remover. 

x. Track individual cells using the “Manual Tracking” plug-in. In Fiji ImageJ, this plugin can be found under
Plugins > Tracking > Manual Tracking. In the “Manual Tracking” plugin, check that the parameters “Time
Interval” and “x/y calibration” match the original experimental setup. 

CRITICAL  STEP:  Several  methods  for  both  manual  and  automated  cell  tracking  are  now  available  for
analysing cell migration (Supp Video 7, 20, 57). We recommend manual tracking as it allows higher flexibility
and because automated software generally work poorly with CDM movies

xi. To start tracking, click on “Add track” (a window containing the tracking data will appear). Using the mouse
click on the centre of the cell you want to track in the first time frame at the beginning of the movie. The
movie will then progress to the next time frame as you continue to click and track the same cell and will
automatically stop at the last frame. To stop the track before the end of the movie (i.e. if the cell leaves the
field of view or starts to divide) click on “End track”. To start a new track click on “Add track”.

CRITICAL STEP: To analyse single cell  migration, avoid tracking dividing, dying or colliding cells. Cell
division  will  affect  migration  speed  and  produce  two  daughter  cells  that  migrate  in  opposite  directions.
Colliding cells will often result in cells changing direction (due to contact inhibition) and therefore affect cell
directionality. To avoid tracking these cells scroll through the movie to quickly identify suitable cells. 

? TROUBLESHOOTING

xii. Once you have finished tracking, save the tracking data by selecting the results windows and by clicking on
“File > Save As”.

xiii. Save the track information as an .xls file and open it using the Chemotaxis tool (a stand-alone software or an
ImageJ plugin that can be freely downloaded from the Ibidi website) for further analyses.

xiv. If the Chemotaxis tool ImageJ plugin is used, click on “import data”, then select the exported tracking data .xls
file. Choose the file in “imported datasets” and select the number of slices to analyse (number of images from
the movie used to do the tracking), then click on “Add dataset”. Up to four datasets can be analysed at the
same time by ticking the boxes “Selected Dataset 1 to 4” then click on “Apply settings”.

xv. Click on the “Settings” tab and check that the calibration matches your experimental setup. Click on “Apply
settings”. To display a summary of each dataset click on “Show info” (Fig. 6b).
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xvi. To analyse cell velocity and cell directionality in each dataset, click on the “Statistic feature” tab and then on
“Velocity” or “Directionality”. Results for each dataset will appear in a new window. Results can then be
further analysed and displayed (Fig. 6c).

? TROUBLESHOOTING

Troubleshooting advice can be found in table 1.

Table 1:  Troubleshooting

STEP PROBLEM Possible reason Solution

9 Fibroblasts  die  when
plated  on  gelatin-
coated coverslips

There is some residual glutaraldehyde in the
well

Increase the number of washes and/
or  add  an  extra  glycine  blocking
step

10 Fibroblasts  appear
stressed  after  ascorbic
acid treatment

Different cell lines have variable sensitivity
towards ascorbic acid

Wait an additional day after plating
before  starting  the  ascorbic  acid
treatment

Optimize  the  concentration  and
frequency  of  ascorbic  acid
treatment

In  particular,  primary  fibroblasts
isolated  from  tissue  benefit  from
either  lowering  the  ascorbic  acid
concentration or plating the cells for
2  days  prior  to  ascorbic  acid
addition. 

11-17 No or only little CDM
visible after  extraction
(see Fig. 3f)

The ascorbic acid had degraded / the length
of  the  ascorbic  acid  treatment  was  not
sufficient

Use only freshly prepared ascorbic
acid  stock  solution  /  optimize  the
length  and  frequency  of  ascorbic
acid treatment

Fibroblast confluence was not optimal at the
time of ascorbic acid treatment

Carefully  check  that  a  fibroblast
monolayer  has  formed  before
starting the ascorbic acid treatment
(see Fig. 3a and 3b). If the cells are
not  sufficiently  confluent,  the
CDMs generated will not be robust
enough  to  withstand  detergent
extraction.

The fibroblasts used are too old Use lower passage fibroblasts

CDMs are lifting off during the extraction See below

11-17 Not  enough  matrix  was  deposited  by  the
cells 

See above
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CDMs detach from the
coverslips (see Fig. 3g
and 3h)

The washes were too strong Use gentler washing strategies. For
instance it is critical to avoid drying
of the CDM. Therefore, it is best to
always  leave  some  liquid  in  the
wells while performing the washes.
Additionally,  perform  the  washes
using  serological  pipettes  rather
than  pipette  tips  to  decrease  the
liquid flow speed.

The extraction is too extensive and damages
the CDMs

Carefully  monitor  the  denudation
step  using  light  microscopy  and
adapt  the  length  of  NH4OH-based
extraction accordingly

Step  18,
option C 
(ix-xvi)

Cells are too confluent
and  cannot  be  easily
tracked

Too many cells were plated Plate cells at lower density

Cells  are  dividing  too
often and non-dividing
cells  are  difficult  to
track

The serum concentration or the presence of
growth factor in the medium is too mitogenic

Reduce  serum  or  growth  factor
concentration  or  perform  the
migration experiment in serum-free
conditions

TIMING

Steps 1-17 - generation of CDMs by fibroblasts (Timing 8-22 days)
Steps 1-6: Preparation of gelatin-coated coverslips (Timing 2-2.5 h)
Steps 7-10: CDM production by fibroblasts (Timing 7-21 days)
Steps 11-17: CDM extraction (Timing 1 h)

Step 18 - further analyses using CDMs
Option A: Immunofluorescence staining of CDMs (Timing 3-3.5 h)
Option B: Analysis of cell proliferation on CDMs using IncuCyte-ZOOM® (Timing: 2-5 days)
Option C i-viii: Analysis of directional cell migration on CDMs (Timing 1-2 days)
Option C ix-xvi: Quantification of cell migration on CDMs by cell tracking using ImageJ and the Chemotaxis
tool (Timing: 2-5 days)

ANTICIPATED RESULTS

The protocol described here will guide users into producing and using CDMs for cell biology experiments. In particular,
we show representative images of CDM structure (Fig. 1, Fig. 3 and Fig. 4) and demonstrate how CDMs can be used to
quantify cancer cell proliferation and migration (Fig. 5 and Fig. 6) following re-plating. CDM production is relatively
easy  to  implement  and  does  not  require  specialised  equipment;  however,  the  protocol  does  contain  several
delicate/important  steps critical  for efficient  CDM generation.  To help users through these critical  points,  we have
provided Supplementary Videos 1-7 as well as detailed troubleshooting guidelines with associated figures. One key
factor  in successful  CDM production is to ensure that ascorbic acid treatment is initiated only when the fibroblast
monolayer is sufficiently confluent (see Fig. 3a and 3b). When cells have deposited a matrix, the main pitfall for new
users is to know what an extracted CDM should look like following cell denudation. Several bright-field images of
CDMs are available throughout the figures.  In particular,  Fig. 3 displays typical  examples of properly formed and
improperly formed or partially destroyed CDMs. Since the biochemical and biophysical properties of the CDMs are
highly dependent on the quality of the fibroblasts producing them, it is essential to validate the CDMs prior to use. The
simplest validation of CDMs can be performed using a bright-field microscope and this often provides a good indication
of  matrix  quality  (Fig.  3).  However,  we  recommend  further  steps  to  confirm  the  usability  of  the  CDM  batch,
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particularly before use in extensive analyses.  CDM architecture,  protein composition, quality and thickness can be
assessed rapidly by immunofluorescence staining of abundant ECM proteins (Fig. 4). Another way to validate CDMs is
by performing replating experiments. Cells plated on CDMs adopt an elongated morphology that is notably distinct
from the morphology of cells plated in 2D conditions or in cells sensing the underlying rigid glass surface where the
CDM is thin or has been partially removed (Fig. 3). In addition, AFM is an effective technique to quantify CDM
stiffness, and we have found that CDMs with a thickness of 10-15 μm). Thism typically exhibit a maximum stiffness of 100
pascals 11.

The second part  of the protocol describes  how to use CDMs to gain biological  insights.  The immunofluorescence
approach described here combined with other microscopy techniques, to define physical properties, and targeted and/or
global analyses of CDM composition can be a powerful technique for comparing matrices produced by different cell
types and/or by the same cells in response to stimuli or in a disease setting. Importantly, the contribution of these
different CDMs to cell behaviour can be analysed using replating experiments and provides an ideal environment to
monitor stromal-induced changes in cell fate. For example, using CDMs to study cancer cell proliferation can provide
important information about matrix-guided biological processes since stiffness and matrix composition are significant
regulators of cancer cell growth. Importantly, CDM stiffness has been shown to be in range of tissue explants 11, 18, 19, 58

and reconstituted basement membrane, further advocating the use of CDMs as in vivo-like model systems for studying
cancer cell proliferation. In Fig. 5 we provide a comparison between the proliferative rates of HeLa-H2B-GFP cells
plated either on TIF CDMs or on classical cell culture plastic, and show that CDMs generated by “normal” fibroblasts
are growth-inhibitory  11. Additionally, we have used fibroblast CDMs to analyse cancer cell migration (Fig. 6). The
advantage of CDMs for this purpose lies in their highly oriented nature, in which cells use the linear matrix fibres to
navigate through the matrix in a directional manner. Here, we describe live-cell imaging, tracking and quantification of
cancer cell migration on top of CDMs. As an example we have investigated the effect of protein kinase C β (PKC β)-
inhibitor enzastaurin and PI3-kinase inhibitor LY294002 on directional cell migration (Fig. 6). These data highlight that
while both enzastaurin and LY294002 treatments decrease cell directionality on CDMs, only enzastaurin treatment
significantly affects cell speed 20.

Figure legends

Figure 1: Cell morphology on different in vitro matrices and in vivo

a-c: Representative bright-field images of MDA-MB-231 breast cancer cells plated in 2D culture (a) and on telomerase-
immortalised human fibroblast (TIF) CDMs (b, c). Matrix fibres and elongated cell morphology are clearly visible in
the higher magnification of the CDM (c). Insets denote magnified regions of interest. Scale bars = 400 μm). Thism (a, b) and
100 μm). Thism (c). d: Example picture of an MDA-MB-231 breast cancer cells plated on a 2D glass surface (pre-coated with
fibronectin),  stained  with  phalloidin  (to  visualized  the  actin  cytoskeleton)  and  imaged  using  a  total  interference
reflection microscope (scale bar = 25 µm). e: Example picture of MDA-MB-231 cells plated on a 3D collagen gel (5
mg/ml bovine type I collagen, polymerized at +37 °C for 5 min), stained with phalloidin and imaged using a confocal
microscope (maximal projection is displayed; scale bar = 25 µm). f: Example picture of MDA-MB-231 cells plated on a
TIF CDM, stained with phalloidin and imaged using a confocal microscope (maximal projection is displayed; scale bar
= 25 µm).  g: Example of a breast cancer cell (MCF10 DCIS.com cell) migrating out of a tumour in vivo. MCF10
DCIS.com cells stably expressing Lifeact RFP were subcutaneously injected in mice. Tumours were allowed to grow
for three weeks, dissected, embedded in paraffin and sections imaged using a spinning disk microscope (a single Z
section is displayed, scale bar = 25 µm). h: Collagen organization in a 3D collagen gel (polymerized as in e), visualized
by spiking in 1 µg/ml of fluorescently labelled collagen I (DQ collagen) prior to gel polymerization, and imaged on a
confocal microscope (maximal projection is displayed; scale bar = 25 µm).  i: Collagen organization in a TIF CDM
visualized by immunostaining of collagen I and imaged on a confocal microscope (maximal projection is displayed;
scale bar = 50 µm). j: Still images of an A2780 ovarian carcinoma cell, transiently expressing Lifeact RFP (to visualize
the actin cytoskeleton), migrating live on TIF CDMs (labelled in green using Alexa Fluor 488 recombinant fibronectin).
Images  were  acquired  on  a  spinning  disk  microscope  using  a  63x  objective  (see  Video  8,  data  obtained  whilst
performing experiments in ref 24, however this specific video has not been published previously).
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Figure 2. work-flow cartoon.

A brief summary of the protocol and timeline for generating CDMs. Several potential uses for CDMs have also been
outlined. These include downstream analysis of the deposited matrix (e.g. visualization of matrix architecture using
microscopy techniques or dissection of matrix components) and replating experiments to shed light on cell signalling
and behaviour in a more in vivo-like microenvironment and/or in response to CDMs produced by different stromal
cells. IF: immunofluorescence, SHG: second-harmonic generation, EM: electron microscopy, SEM, scanning electron
microscopy, WB: western blotting, MS: mass spectrometry.  Scale bars = 2 μm). Thism for SEM image and 50 μm). Thism for  IF
images. 

Figure 3. Common problems associated with CDM production.

a, b: Bright-field images highlighting TIF morphology and confluence during CDM production. Shown are examples of
a non-confluent (a; arrows highlight gaps between cells) and a confluent TIF monolayer (b) where the fibroblasts are
aligned and packed tightly against one another. If gaps are visible between cells (as in a), it is recommended to delay
ascorbic acid treatment until a monolayer has formed (as in b). c: Bright-field images highlighting a tightly packed TIF
monolayer following 7 days of culture and daily ascorbic acid treatment in the absence of extraction buffer (left image)
and after addition of extraction buffer (no PBS wash) to denude the cells (right image).  d-h: IncuCyte bright-field
images of extracted TIF CDMs. Normal TIF CDM morphology is shown following ascorbic acid treatment on alternate
days (d) or every day (e).  TIF CDMs are fibrillar in nature and cells plated on these CDMs display an elongated
morphology with, predominately, a single leading edge and retracting tail. Common problems associated with CDMs
include gaps in the normal uniform distribution of the matrix (f, g). This could arise from insufficient deposition of
matrix due to low TIF confluence (as in f) or due to damage to CDMs during extraction (as in g). In these cases,
replated MDA-MB-231 cells are exposed to and/or can sense the underlying tissue-culture glass and lose their CDM-
associated elongated morphology. Other common issues include peeling off of the CDM from the glass coverslip (h).
Insets represent magnified regions of interest (dark purple insets: cell-free CDM; green insets: MDA-MB-231 cells
plated on CDMs). Arrows indicate MDA-MB-231 cells (green arrows: cells migrating on CDMs; pink: cells exposed to
and migrating on glass). All scale bars = 400 μm). Thism. 

Figure 4. Immunofluorescence imaging of collagen I and fibronectin in CDMs.

a: Example immunofluorescence images of CDMs produced by TIFs (ascorbic acid-containing medium was changed
every day for 10 days), stained for collagen I (left panel) and fibronectin (right panel) and imaged using a confocal
microscope (maximal projections are displayed; scale bar = 50 µm; data obtained whilst performing experiments in ref
11,  however  these  specific  images  have  not  been  published  previously).  b: Immunofluorescence  image of  CDMs
produced by mouse mammary stromal fibroblasts (ascorbic acid-containing medium was changed every day over 10
days). CDMs were stained for collagen I and imaged on a confocal microscope (a  maximal projection is displayed;
scale bar = 50 µm; data obtained whilst performing experiments in ref 13, however these specific images have not been
published  previously).  c: Example  immunofluorescence  images  of  CDMs produced  by  fibroblasts  isolated  from a
HNSCC patient (ascorbic acid-containing medium was changed every day over 21 days). CAFs were isolated from the
primary tumour site (buccal mucosa) while the normal fibroblasts were isolated from a non-cancerous region. CDMs
were stained for collagen I (left panels) and fibronectin (right panels) and imaged on a confocal microscope (maximal
projections are displayed; scale bar = 50 µm; data obtained whilst performing experiments in ref 11, however these
specific images have not been published previously). 

Figure 5: Comparison of HeLa-H2B-GFP cell proliferation on CDMs and on plastic

a: Representative  images  of  HeLa-H2B-GFP cells  plated  on  CDMs or  on  plastic  and  imaged  using  an  IncuCyte
ZOOM® system.  b-c: Analysis  of  HeLa-H2B-GFP  cell  proliferation.  The  number  of  cells  was  determined  using
fluorescence-based thresholding (b; example of cells plated on plastic is shown) and cell proliferation was quantified
over 4 days (c). Paired t-test was used for statistical analysis (n = 3; mean ± SD; all data points are shown; p-value
calculated for the last time point). 
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Figure 6: Analysis of cell migration on CDMs.

a: A representative field of view illustrating the morphology of MDA-MB-231 breast cancer cells migrating on CDMs.
Inset represents magnified region of interest (scale bar = 200 µm). b-c: MDA-MB-231 cells were plated on CDMs for 4
h in the presence of DMSO, 10 µM enzastaurin (protein kinase C inhibitor) or 10 µM LY294002 (PI3K inhibitor) and
cell migration was recorded over 24 h and manually tracked using ImageJ. For each condition, spider plots (30 cell
tracks; red tracks highlight cells with directionality below 0.5) were created (b), and cell directionality and cell speed (c)
were analysed using the ImageJ Chemotaxis Tool.  Statistical analyses: student’s t-test, unpaired, two-tailed, unequal
variance (n = 3 biological replicates with > 80 cells tracked for each condition; Tukey box plots represent median and
interquartile range (IQR). Whiskers extend to data points within 1.5 x IQR from the 1st/3rd quartile; all data points are
shown as circles; these data were obtained whilst performing experiments in ref 20, however this specific data-set has
not been published previously).

Supplementary videos

Video 1

Video 1 outlines the entire work-flow used to generate CDMs.

Video 2

Video 2 shows how to prepare gelatin-coated coverslips (Steps 1-6 of the protocol).

Video 3

Video 3 shows how to plate fibroblasts for CDM production (Steps 7-10 of the protocol).

Video 4

Video 4 shows how to extract CDMs (Steps 11-17 of the protocol).

Video 5

Video 5 shows how to stain CDMs using immunofluorescence (Step 18, option A of the protocol).

Video 6

Video 6 shows how to analyse cell  proliferation on CDMs using an IncuCyte-ZOOM® (Steps 18, option B of the
protocol).

Video 7

Video 7 shows how to quantify cell migration on CDMs using ImageJ and the Chemotaxis tool (Step 18, option C of
the protocol).

Video 8

Video 8 shows an  ovarian  carcinoma cell  transiently  expressing  Lifeact  RFP (to visualize  the actin  cytoskeleton)
migrating on TIF CDMs (labelled in green using Alexa Fluor 488 recombinant fibronectin). Images were acquired on a
spinning disk microscope using a 63x objective.
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